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TIP

Enter your jobs
Job refers to any task performed by your volunteers at a shift. For each shift, 
you can specify how many volunteers should be scheduled in each job. 

 1. Click on the Jobs pane. 

 2. Click “New Job.” 

 3. Name your job.

1 Skills and tasks

Subdivisions are used to distinguish between 
different positions within the same job by task 
or skill, such as scheduling Ushers at a specific 
location or designating who is a Head Nurse. 
You can specify different volunteers to be 
qualified to serve in each subdivision you create. 
Each volunteer can be designated for more than 
one subdivision when appropriate. 



Creating a schedule

After you have entered all your jobs, create a schedule. Note that 
all the shifts and jobs that will occur within this time period will be 
included on this “master schedule.” 

 1. Click on the Schedules pane. 

 2. Enter the start and end dates for a schedule, and then  
     click the “Create…” button. 

 3. Click on a day in the calendar on which one of your shifts  
     takes place, and then click the “New Shift...” button at the 
     top of the window.

 4. In the dialog that appears, set the start and end time for  
     the shift. 

 5. If the shift repeats on other days of the week, or monthly  
     or yearly, use the controls under the “Repeats” heading to  
     set up the appropriate repeating pattern.

 6. Specify how many volunteers from each job are required 
     for this shift.

 7. Click “OK.” 

 8. Repeat this process for all your other shifts.
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When you have finished creating all your shifts: 

 1. Choose “Save” from the File menu at the top of the  
     schedule window. 

 2. A dialog will open asking you to enter a name for the   
     schedule. Be sure the box is checked to “Make this  
     schedule live now” and select the option to “Just use the 
     default layout for now.”

 3. Click “OK.”



Enter your volunteers

Volunteer refers to any person who will be scheduled in any of your 
jobs. There are several ways to go about entering your volunteers: 

 Manually   enter volunteers to customize their  
 complete profile.

  1. Click the “New Volunteer...” button on the right  
       side of the Volunteers pane. 

  2. Add the volunteer name, email, and qualified  
      jobs, as well as any other information you want 
      to track about that volunteer. 
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 Import   volunteer contact information and custom fields  
 from a .txt, .csv, .xls or .xlsx file. We recommend importing  
 one spreadsheet per job so you can quickly qualify  
 volunteers for their jobs during import. 

    Watch this video to learn how to set up a spreadsheet and  
 import your volunteers. 

  1. Go to File - Import Volunteers.

  2. From the menu under Available Fields, select the 
      irst field name listed on your spreadsheet, then 
      click the “Add” to add it to the Fields to Import 
      list on the right. Repeat this process for each field  
      you wish to import in the order they appear on  
      your spreadsheet.

  3. If appropriate, go to the Job Qualifications menu  
      below and select each job for which every 
      volunteer on the spreadsheet to be imported 
      will qualify.

  4. Click the “Import” button at bottom, then choose 
      your spreadsheet.

https://www.volunteerschedulerpro.com/video/80


TIP

 Email an online enrollment form   to a list of volunteers or contacts  
 in order to collect their necessary information for your database.  
 As people enroll, they will be added to the database as volunteers. 

    Watch this video for a walkthrough of the full enrollment form  
 setup process. 

  To see the enrollment form:

  1. Click on the Web Terminal pane on the left hand side  
      of VSP’s main screen. 

  2. At the top of the pane, click “Web Terminal Settings”  
      and then click the Enrollments pane on the left. 

  3. The Enrollment URL at the top is the direct link to  
      your form, You can click this to view or to send to  
      your volunteers.
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cont’d

Recommended settings

Some settings of the volunteer profile are used 
to track volunteer availability and preferences. 
You will not need to use these sections if you 
are primarily having volunteers sign up for shifts 
online. You will only need to use the “Shift 
preferences” and “Preferred serving frequency” 
sections if you are using the availability based 
rotation model. 

Shift preferences in the volunteer profile 
allow the auto-scheduler to prioritize the shift 
preferences in the order they appear on this list. 
If you do not check the “Schedule only at these 
times” box, VSP may schedule the volunteer at 
other shifts when needed.

Preferred serving frequency can be used to 
set a request on how often the auto-scheduler 
places a volunteer to serve. However, we highly 
recommend leaving most of your volunteers’ 
frequency set to “Normal” to allow the auto-
scheduler the most flexibility when creating  
your schedule.

https://www.volunteerschedulerpro.com/video/86


Scheduling volunteers
VSP accommodates many forms of scheduling, and you can mix and 
match to find the right method for your organization.

 Self sign-up:  Volunteers sign up for shifts online

 1. Click the “Log in as...” button found in the lower right- 
     hand corner of the Web Terminal pane. 

 2. Choose a volunteer. Log in to the Web Terminal as if you  
     were that person. 

 3. Click on the “Full Schedules” tab at the top of the page,  
     and then click on an unfilled position to sign up for a shift. 

 4. Once you submit the request, go back into VSP (minimize  
     or close the web browser window) and click on the Web  
     Forms pane on the left-hand side of VSP’s main screen.  
     You’ll see an “Assignment form” in the list that represents  
     the assignment request you submitted online. Click the  
     “Process Form” button. 

 5. You can optionally set up these forms to be automatically  
     processed so that the assignments are made in real time as  
     soon as the forms are submitted.
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 Manual:  Hand pick the volunteers you want to serve and  
 get notification of any potential conflicts

 1. Open the saved schedule you created in step 2 of  
     these instructions.

 2. Click on one of the empty positions in a shift. Notice that  
     the volunteer list on the right-hand side of the window  
     shows the volunteers who are eligible and available to fill  
     the selected position.

 3. To fill the position with one of the volunteers in the list,  
     double-click or drag-and-drop the volunteer whom you  
     wish to assign.

https://rotundasoftware.screenstepslive.com/s/VSP/m/58335/l/717677-how-can-i-set-up-my-web-forms-to-process-automatically
https://rotundasoftware.screenstepslive.com/s/VSP/m/58335/l/717677-how-can-i-set-up-my-web-forms-to-process-automatically
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 Preassignments:  Set volunteers to repeat on a pattern 

 Click here for a video on how to set up rotating assignments. 

 1. After manually placing a volunteer on the schedule, click  
     the “Repeats” button. 

 2. Set the repeating pattern for the chosen volunteer. 

 3. Click “OK.” The volunteer will now be placed in the  
     rotating pattern on this schedule and all future schedules. 

  Auto-scheduler:  Click a button and let VSP assign your  
 volunteers based on their preferences and settings

 1. Click the “Auto Schedule” button in the upper right corner  
     of the schedule window. 

 2. The auto-scheduler will ensure that volunteers are not  
     scheduled during any of their “Unavailable times,” that  
     each volunteer’s shift preferences and preferred serving  
     frequency settings are honored, and that each volunteer  
     appears on the schedule regularly.

https://www.volunteerschedulerpro.com/video/81


TIP

Customizing VSP for your organization

Custom fields, available in the Standard edition, can be used to 
collect and track volunteer information that is not reflected in the 
predetermined fields within VSP. Examples of common custom fields 
include t-shirt size, birthday, certifications, and more. Custom fields 
can be added to the enrollment form and the My Profile form so that 
volunteers can update these fields themselves online.

Click here for a video on how to set up custom fields. 

 1. Go to the Volunteers pane and click “New Volunteer…” 

 2. In the new window, click the “Edit Custom  
     Fields…” button.

 3. Click the “Manage fields...” button. 

 4. Click the “Create New Field” button. 

 5. You have different options for custom fields: text,  
     number, date, checkbox, and list of options. Once  
     you create the field it will appear in the main part of  
     the screen. 

 6. Click OK once you have added all the custom fields you  
     wish to track.

Web Terminal settings allow you to further customize how 
volunteers interact with VSP through the Web Terminal. (NOTE: Web 
Terminal settings are not available during the 15-day free trial.)

 1. Click on the Web Terminal pane on the left-hand side of  
     VSP’s main screen.

 2. Click the “Web Terminal Settings” button at the top of the  
     Home tab. 

In the dialog that appears, you will find a variety of customization 
options. Among many other options, you can:

 • Customize the text of automatic email reminders

 • Turn on automatic text message (SMS) reminders

 • Turn on automatic processing for web forms, so that  
    requests that volunteers make through the Web Terminal  
    are processed immediately rather than held for manual  
    processing at a later time.

 • Brand the Web Terminal with your organization’s logo

 • Customize the profile information that volunteers can  
    update in the My Profile tab. For instance, you can hide  
    the shift preferences and unavailable times areas, or you  
    may include custom fields on the My Profile tab.

https://www.volunteerschedulerpro.com/video/92


Giving volunteers online access  
to the Web Terminal
When you are ready, send your volunteers an email through the 
Announcements pane to let them know how to log in to the Web 
Terminal. (NOTE: You can set up Announcements but you cannot 
send them during the 15-day free trial.) 

 1. Click on the Announcements pane on the left-hand side  
     of VSP’s main screen. 

 2. Click the “+” button in the upper right and select  
     “Templates” and then “Preconfigured.” 

 3. Select one of the “Introductory email” templates to send  
     your volunteers that will provide them with the link to  
     your Web Terminal homepage and their personal  
     usernames and passwords that are automatically  
     generated for them by VSP. Tokens enclosed in {{curly  
     brackets}} will be replaced with the appropriate  
     information for each volunteer when the email is sent.  
     Feel free to customize the email to best suit your  
     organization’s needs – you can add and remove text and  
     tokens as needed by typing into the text box.

 4. Click the “Preview” button, then click on a  
     volunteer’s name to see how the email will look when sent  
     to each volunteer. 
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We also recommend that you post a link to your Web Terminal’s 
home page on your organization’s website so that your volunteers 
can access their schedules by visiting your organization’s site. 

 1. Go to the Web Terminal pane on VSP’s main screen, and  
     then click the “Copy...” button in the top right corner  
     of the Home tab. 

 2. Send an email to your organization’s webmaster and  
     choose “Paste” from the “Edit” menu to paste the link into  
     the email with a request to post it on your site.



Conclusion 

Congratulations! You have completed the setup work of entering your jobs, creating a schedule, and adding volunteers. You should now 
have a clearer idea of how VSP can work for your organization.

For more help getting started with VSP, visit our Help Center. There, you will find: 

 • Video tutorials on specific features in the program, including those not covered in this guide, such as how to print the  
    schedule, customize the online layouts, and send text messages

 • Step-by-step instructions for many common questions and setups

 • The user manual, which helps explain the many different options found within the program

Need additional help? 
Contact support by sending in your data files (Help - Send Data Files to Tech Support) or call us at 888-877-3640.

We also have guides available Salvation Army Kettles, Adoration, or events.

https://www.volunteerschedulerpro.com/help-center
https://www.volunteerschedulerpro.com/resources#video-tutorials
https://rotundasoftware.screenstepslive.com/s/VSP
http://www.rotundasoftware.com/volunteerschedulerpro/resources/onlineDocumentation/
https://www.volunteerschedulerpro.com/resources/Quick.Start.Guide_SA.pdf
https://www.volunteerschedulerpro.com/resources/adoration-QuickStartGuide.pdf
https://www.volunteerschedulerpro.com/resources/events-QuickStartGuide.pdf

